PowerTeacher Pro for Teachers Part Two

Introduction

PowerSchool's HTML-based gradebook, PowerTeacher Pro, includes advanced features for standards-based grading, traditional grading, student performance analysis, and reporting.

In this course, learn how to use the gradebook to:

- Work with final grades
- Assess student and class performance
- Run PowerTeacher Pro reports

Working with Final Grades

Final grades are updated automatically throughout the term as you enter assignment scores in the gradebook. When the term comes to a close, however, you may have additional tasks to perform before submitting grades for report cards to make sure your final grades are accurate. For example, you may have to enter standards grades, modify individual scores, or enter citizenship scores. Occasionally, you may also need to modify a student's final grade in a course based on effort, participation, or other performance factors.

Interaction 1 – Slides
Final Grades: Traditional

View traditional grades for a class, enter citizenship scores, and view a summary of how many absences, tardies, missing assignments, late assignments, and incomplete assignments each student has.

Review how to work with final grades in the gradebook. Click to view slide(s).

To work with final grades, click Grading and use the links in the Grades section. Access the same links through the Quick Menu—the arrow next to the heading at the top of the grading pages.

Click Traditional to view the traditional grades for an entire class, along with a summary of how many absences, tardies, missing assignments, late assignments, and incomplete assignments each student has. To edit the final grades, click in the first column and edit the data in the Score Inspector. The grades correspond to the reporting term you select in the term menu in the top-right corner of the page. To see grades for a different term, open the term menu and select a reporting term code.

Open the Quick Menu and click Standards to view or edit the standards grades for an entire class for the selected term. If you see the Professional Judgment Indicator, note the student's name and the standard label. Then click Students, select the student, and click Standards Progress. Locate the standard on the student's Standards Progress page. Scroll, if necessary, to see the term that features the indicator. Click the assignments icon at the right to view a graph of all scores on assignments aligned
to that standard. You will probably see that one of the most recent scores doesn't seem to fit the pattern the student displayed through the rest of the term. If his performance on that assignment does not accurately reflect his mastery of that standard, modify the final grade for the standard.

Return to the Grading options and choose Comment Verification to view or add final grades comments. Use this page when you are getting ready to complete grades for report cards. To add or edit a comment, click a student's final grades and click the Comment icon in the Score Inspector. Add comments for additional students and click Save.

Open the Quick Menu and select Category Totals to view a summary of students' grades by assignment category. Use category totals to assess how students performed in one assignment category versus another, or to analyze the difficulty of one category type versus another. For example, if students received significantly lower scores on assignments in the Homework category than in the Test category, you might revisit the homework assignments and analyze their difficulty.

To view and work with students' final grades from all reporting terms, open the Quick Menu and click All Reporting Terms. Each column represents a reporting term. The column that corresponds to the current term is highlighted. Click a student's final grades for a reporting term and use the Score Inspector to modify scores or add comments.

Click Save after you make any grading changes. When you change a final grade manually, the cell that contains the student's final grade will have a small triangle in the upper-left corner, indicating that the grade has been modified manually. The Score Inspector will display both the modified grade and the original calculated grade. To revert to the calculated grade, click the Undo icon in the Score Inspector.

To work with the final grades for students in another class, click the name of the currently selected class at the top of the gradebook window and choose a different class.

Activity 1 – Modify a Final Grade

You've evaluated a student's performance and found that you need to modify the student's final grade to account for increased effort and demonstration of standards mastery. Edit the student's final traditional and standards grades in the gradebook.

1. Click Grading
2. Click Traditional
3. Click a student's final grade
4. In the Score Inspector, edit the student's grade to be higher than it is currently

   For example, change a letter grade of A- to A and a percentage of 91 to 94.

5. Click Save

   Notice that the student's final grade cell has a small triangle in the upper-left corner, which indicates that the grade has been modified manually.

6. Open the Quick Menu and select Standards
7. Click a standards grade for the same student and edit it to be higher than it is currently

   For example, change a score of 3 to 4 or a score of M to E.

8. Click Save

Entering Citizenship Scores

If your school doesn't track behavior through standards, then your district leaders may enable citizenship score entry and set up a citizenship scale that includes codes, like S for Satisfactory or N for Needs Improvement, for you to use in PowerTeacher Pro.

Activity 2 – Enter Citizenship Scores

Enter citizenship scores that will appear on students' report cards.

1. Click Grading
2. Click Traditional
3. Click in a student's cell in the Citizenship column
4. In the Score Inspector, select a citizenship score, such as S
5. Enter citizenship scores for several other students
6. Click Save

Recalculating Final Grades

Although final grades in PowerTeacher Pro are calculated automatically, you can force a recalculation, if necessary. Use the recalculate tool after making significant changes in the gradebook, such as adding multiple assignment scores for students who transferred from another class. Also, recalculate grades when your PowerSchool administrator changes a setting that affects the gradebook, such as the grade calculation formula.

To use the recalculate tool, click Settings and then select Recalculate Final Grades. Select the classes for which you are recalculating grades. To recalculate traditional grades, check Traditional Final Grades. To recalculate standards scores, check Standards Final Grades. Then click Recalculate.

Analyzing Performance

Use the gradebook to analyze student performance at any time during the school year. Analyze performance throughout the term to ensure that students are mastering the skills and standards you are teaching. Review students’ performance as you prepare to complete final grades for report cards, and then use the gradebook to prepare for and conduct parent-teacher conferences.

Review how students in an entire class are performing using the Progress pages. The individual student pages provide helpful information during parent-teacher conferences to explain why a student earned a particular grade.

Interaction 2 – Slides

**Individual Student: Assignments**

View a summary of one student’s grades and assignments for the selected reporting term.

<table>
<thead>
<tr>
<th>Assignment</th>
<th>Score</th>
<th>Due Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>WS Pg. 46</td>
<td>83</td>
<td>1/16/2017</td>
</tr>
<tr>
<td>Unit Test</td>
<td>90</td>
<td>1/14/2017</td>
</tr>
<tr>
<td>Problems 11-19</td>
<td>71</td>
<td>1/14/2017</td>
</tr>
<tr>
<td>Chap 10 Sec 1 Review</td>
<td>29</td>
<td>1/6/2017</td>
</tr>
</tbody>
</table>

Students > (select a student) > Assignments

Review how to analyze an individual student’s performance. Click to view slide(s).

**Individual Student Performance**

To analyze an individual student's performance, begin by selecting the class the student is in at the top of the gradebook window. Then, click Students and select the student.

**Assignments**

To view a summary of the student's grades and assignments for the selected reporting term, click Assignments. The Assignments student page is similar to the Assignments page you view for the entire class, except that it shows only the assignments and scores for the selected student. View a summary of the student's course grades at the top of the page. Click the gear icon next to the term menu and choose Show Filter to use the filter to search for assignments by assignment name, due date, score, or standards. The assignments are listed by the most recent due date by default. To view the details of the standards that are aligned to an assignment, click the icon in the Standards column. Click OK to close the Assignment Standards Detail window.

**Standards Progress**

To navigate to the student’s other pages, use the Quick Menu. For example, to view the student's standards grades, open the Quick Menu, scroll down below the list of student names to the Student View submenu, and select Standards Progress. The Standards Progress page shows the student's standards grades for each standard that was assessed by reporting term. The column that corresponds to the selected term is highlighted. Compare the grades the student received in each term to assess his or her progress.
To view the assignments that you used to assess the standard, click the icon in the Assignments column. Use the graph at the top of the page to see how the student performed over time on the standard. For example, if the standard was assessed on four assignments, you can see the four standards scores the student received. If the calculation method is set to the three most recent scores, you can see those scores next to green circles on the graph and a dotted line that represents the calculated score.

In this example, you can see that the student's calculated standards score is 2+, based on the three most recent scores. You can also see that the student's demonstration of standard mastery decreased over the three most recent scores, so use your professional judgment to determine whether or not the student truly mastered the standard.

![Graph showing the student's scores over time.](image)

To see a summary of the standards scores statistics, click Show Metrics below the graph.

- Most Recent – The average of the most recent score(s)
- Mean – The mathematical average of the scores
- Median – The middle of the scores (half of the scores are above this number and half are below)
- Mode – The most common score achieved
- Weighted Mean – The average of the scores based on the average of total weighted points
- Highest – The highest score

These statistical values are indicators of how well the student did on a specific standard. If any of the values are low, it may mean that the student needs additional practice on the skill or concept you're assessing, or you may need to revise the assignment. To view the student's performance on additional standards, open the Quick Menu and select a standard.

The orange Professional Judgment Indicator may appear next to a student's standard score on the Standards Progress page when evidence exists for mastery that may differ from the student's calculated standard score. To evaluate the student's level of mastery, click the Assignments icon next to the standard score.

![Table showing the standards progress.](image)

In the example below, the student earned a standard score of 2 on most of the assignments, except for the last one. The student's calculated score is based on the three most recent scores, so the last score is included in the calculation, bringing his overall score down to a 2-. Use your professional judgment to evaluate whether or not the calculated score is a true indication of the student's level of mastery. For example, if the student was ill or had a bad test day, the last score may not be a true indicator of his skill level, so you could choose to ignore that score and change the calculated score from a 2- to a 2.
Graphing Additional Standards or Metrics

To compare a student's progress on up to four standards, click the gear icon next to the term menu on the Standards Progress page. Then click Progress Options. In the Progress Options window, select the standards you want to include in the comparison and click OK. Then, click the Show/Hide Graphs icon next to the gear icon to view the student's progress on all of the selected standards. Click one of the symbols, such as a triangle, on one of the line graphs for a different standard to highlight it and view the scores. Below the graph, view the calculated standard grades, the metrics, the aligned assignments, and the scores for the standards included in the comparison.

By default, the Standards Progress graph displays a green dotted line that corresponds to calculated standard score for the term, determined by the chosen metric, such as Most Recent.

To add additional metrics to the graph, click the gear icon next to the term menu on the Standards Progress page and select Progress Options. In the Progress Options window, open the "Additional Metric To Graph" menu and select a metric, such as Highest. Then click OK. A gray dotted line appears on the graph, indicating the score that corresponds to the selected metric.
Comment Log

To view all of the comments you've recorded for the student, click Students and select Comment Log. Depending on the types of comments you've entered for the student, the comment log may show class grade comments, standards grade comments, and assignment comments.

Demographics

To view the student's demographics information, such as his date of birth or mother's phone number, open the Quick Menu and select Demographics.

Quick Lookup

To view the student's traditional Quick Lookup page, open the Quick Menu and select Quick Lookup - Traditional. The traditional Quick Lookup page is the same page that administrators see in PowerSchool and shows the student's attendance for the last two weeks, his current schedule, his current grades, a summary of his total absences and tardies, and his current GPA.

Click a final grade to see the scores and flags for the student's assignments, and to see the standards score information. Click the Standards icon to view the standards aligned to an assignment. Parents, students, and administrators will also see this information for all PowerTeacher Pro sections.

PowerTeacher Pro Assignments

To view the student's standards Quick Lookup page, open the Quick Menu and select Quick Lookup - Standards. Then click the arrow next to one of the student's classes to view the standards aligned to the course and the student's standards final grades. Click a standard final grade to view details about it.

PowerTeacher Portal

To view the selected student's screens in PowerTeacher, open the Quick Menu and select PowerTeacher Portal. PowerTeacher opens in a new window so that you don't lose your place in PowerTeacher Pro and one of the student's screens is visible. The screen that appears depends on which screen you set up to be the default student screen in PowerTeacher. For example, you may see the student's Schedule screen.

Activity 3 – Review an Individual Student's Progress

Review a student's performance using the Assignments and Standards Progress student pages.
1. At the top of the gradebook window, select a class
2. Click Students
3. To view the selected student's performance, click Assignments
4. Review the student's course grades and individual assignment scores, then open the Quick Menu and select Standards Progress
5. Review the student's standards scores for each reporting term, then click the Assignments icon for one of the standards
6. Review the graph of standards scores, then click Show Metrics to review the student's statistical values for scores on assignments aligned to this standard
7. Click Students and select a different student to view his or her Standards Progress page

Activity 4 – Find Attendance Information on the Quick Lookup Page

Find a student who has a missing assignment from the previous week, then check the student's attendance information to see if an absence accounts for the missing work.

1. Click Grading
2. Select Scoresheet
3. Click Show Assignments from Most Recent
4. Scroll through the table to find a student who either has no score or a Late, Missing, or Exempt flag for an assignment from last week
5. Click the student's name
6. Click the arrow next to the page name at the top of the page to open the Quick Menu
7. Select Quick Lookup – Traditional

In the Attendance By Class section of the table, view the student's attendance for this week and last week. See the total absences and tardies for the current term on the right side of the table.

Class Progress

To analyze the performance of an entire class, begin by selecting the class at the top of the gradebook window. Then, click Progress. Depending on how the gradebook is set up, you can view class progress on traditional grades and standards grades.

Interaction 3 – Slides

Class Progress: Traditional

View the distribution of traditional grades for a class for the selected reporting term.

![Graph of traditional grades]

Progress > Traditional

Review how to analyze class progress in the gradebook. Click to view slide(s).
Traditional

To view traditional grades progress, select Traditional from the Progress menu. The graph on the Traditional Grades Progress page shows the distribution of grades for the class for the selected reporting term.

The column on the left lists the number of students who have earned each traditional grade in the grade scale. The colors in the graph correspond to the grade scale color levels. For example, if the grade scale defines the grades A and A- as dark green, the graph displays a dark green bar that corresponds to the number of students who have an A or A-. The black demarcation line shows where the cutoff is between passing and failing grades. The numbers in the column on the right show the total number of students who have passing grades versus the total number of students who have failing grades.

To the right of the graph, view a summary of the total number of students who have missing, late, or incomplete assignments.

Click the graph to open the Traditional Grades Distribution window. On the left side of the Traditional Grades Distribution window, view the grade distribution for each reporting term in the school year. On the right, view the grade trends of the students in the class for the selected term, compared to the previous term. A red arrow in the Grade column indicates that the student’s grade is trending down between the selected terms. A green arrow indicates an upward trend, while no arrow indicates no change. You can see which students are performing better or worse between terms. To compare trends between a different selection of subsequent terms, click a term in the Grade Distribution column. Click the gear icon in the upper-right corner to select additional trend comparison options. To close the window, click X in the upper-right corner.

Standards

To view standards grades progress, select Standards from the Progress menu. The graph on the Standards Progress page shows the distribution of grades for each standard aligned to the course, for the selected class and reporting term.

All of the standards aligned to the course are listed in the Standards column. To the right of each standard, view a graph that displays the distribution of grades for the class. The colors in the graph correspond to the grade scale color levels. For example, if the grade scale defines the standard grade 4 as dark green, the graph displays a dark green bar that corresponds to the number of students who have a 4. The black demarcation line shows where the cutoff is between passing and failing grades. The numbers above the colored bars show the total number of students who have passing grades versus the total number of students who have failing grades. The graphical display makes it easy to see whether or not students in the class are demonstrating mastery of the standard, and helps you consider your instructional response. If, for example, you find that most of the students have failing grades, you may decide to reteach the concept or provide more opportunities for practice.

Click the graph to open the Standard Grades Distribution window. On the left side of the Standard Grades Distribution window, view the grade distribution for the selected standard for each reporting term in the school year. On the right, view the grade trends of the students in the class for the selected term, compared to the previous term to see which students have mastered the standard and which ones need more practice. A red arrow in the Grade column indicates that the student’s level of mastery is trending down between the selected terms. A green arrow indicates an upward trend, while no arrow indicates no change. To compare trends between a different selection of subsequent terms, click a term in the Grade Distribution column.

To change the display, click the gear icon at the top of the Standard Grades Distribution window. If a course group is currently selected instead of a single course, you might want to display student names by class. Select whether to show empty grades, to display the trend icons, and what term to compare the currently selected term against. To close the window, click X in the upper-right corner.

On the right side of the Standards Progress page, the number in the Assignments column indicates the number of assignments that you’ve used to give students opportunities to practice the standard or to assess their levels of mastery. To view the assignments aligned to a standard, click the Assignments icon. The Standards Assignment Trend window lists the aligned assignments by category, name, due date, and score type. Use this window to analyze the types of assignments that you’ve used to assess the standard, or click the name of an assignment to view or edit the students’ individual scores. To close the window, click X in the upper-right corner.

Activity 5 – Review Class Progress

Review the distribution of traditional and standards grades for a class. Then make changes to students’ standards scores on an assignment and return to the Standards Progress page to review the changes.

1. At the top of the gradebook window, select a class
2. Click Progress
3. Click Traditional
4. View the distribution of traditional grades, then click the graph
5. Compare the students’ grades trends in the current term to the previous term, then select a different term in the Grade Distribution column
6. Close the Traditional Grades Distribution window
7. Click Progress
8. Click Standards
9. For the first standard listed, note the number of students who are demonstrating mastery and the number of students who are not
10. Click the Assignments icon next to the first standard
11. Click the name of the first assignment
12. In the first standard column, change several students’ passing scores to failing scores and then save the scores
13. Navigate back to the Standards Progress page and review how the distribution of grades for the first standard has changed

Running PowerTeacher Pro Reports

The gradebook contains several reports that you can view onscreen or print. Personalize each report by entering a custom title, top and bottom notes, signature line, and by specifying fields to use or criteria to use. The following table provides brief descriptions of the reports:

<table>
<thead>
<tr>
<th>Report Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Individual Student Report</td>
<td>• Use this report to view or print a summary of the class activity per student&lt;br&gt;• Present a summary of student work to parents at conferences or to a principal during a review, or use the report as a midterm update for students and parents&lt;br&gt;• Choose whether or not to include course grades and attendance, assignments, category totals, citizenship scores, and comments&lt;br&gt;• Print the report for a few students or a group</td>
</tr>
<tr>
<td>Multi-Function Assignment Report</td>
<td>• Use this report to view or print a list of students and scores per assignment&lt;br&gt;• Use it to find missing, late, or incomplete assignments, to help students and parents keep up with class work, to target students who need extra help, or to gauge which assignments present the most challenges to students</td>
</tr>
<tr>
<td>Scoresheet Report</td>
<td>• Use this report to print a copy of the Scoresheet page&lt;br&gt;• Include final grades and assignment scores&lt;br&gt;• Use student numbers or names&lt;br&gt;• Sort students by name, student number, or randomly&lt;br&gt;• Use it to post a printout of students' grades&lt;br&gt;• Run the report as a PDF or an Excel spreadsheet</td>
</tr>
<tr>
<td>Student Roster</td>
<td>• Use this report to view or print demographic information by class&lt;br&gt;• Use the report to keep track of money collected for classroom field trips, or as an emergency contact list, for example&lt;br&gt;• Customize the report by adding blank columns (the report retains the information you entered last)&lt;br&gt;• Use the Order arrows to arrange the columns in any order&lt;br&gt;• Run the report as a PDF or an Excel spreadsheet</td>
</tr>
</tbody>
</table>

**PowerTeacher Pro Reports**

PowerTeacher Pro contains reports that you can view onscreen or print.

- Individual Student Report
- Multi-Function Assignment Report
- Scoresheet Report
- Student Roster
Activity 6 – Create Progress Reports

Next week, you have parent-teacher conferences for your struggling students. Provide parents with progress reports for their records.

1. Click Reports
2. Select Individual Student Report
3. Enter a report title, such as Progress Report
4. Open the Classes menu and choose the classes to include on the report
5. In the Sort Options section, open the Layout menu and choose By Section, By Student
6. To sort the report by students' last names, open the Students menu and choose Last Name

To use the preference for how student names are sorted by default in your gradebook that you defined under Settings > Display Settings, choose Gradebook Preference.

7. Use the Assignments menu to sort the assignments by due date or by category and due date; for example, choose Due Date (Newest First) to list the assignments by the most recent due dates
8. Open the Areas To Include menu and check Course Grade Comments and Assignment Comments to include any comments you've entered about the students in the report

"Course Grades and Attendance," Assignments, and Category Totals are checked by default. If citizenship score entry is enabled, select Citizenship to include citizenship scores.

9. Click the Areas To Include menu again to close it
10. To include students' grades from the current term, use the default settings under Date Range
11. Use the default settings under Data Filters to include any assignments, any scores, any category, and any course grades
12. Scroll to the top of the page and click the Students tab
13. To run the report for a selection of students rather than for all of the students in the classes, click Add/Remove Students
14. All of the students are selected by default, so clear the check box to the right of the Filter area, then in the list of students, check the boxes next to the struggling students' names
15. Scroll to the top of the page and click the Format tab
16. Since you are including all of the available data in the report, leave the page orientation set to Landscape to make the text easier to read
17. Use the default option PDF for the report output
18. To create a page break between students, check Page Break
19. Choose to exclude row shading to save ink during printing
20. Leave the "Include" check box clear for the Top Note option, since you don't plan to include a note at the top of the report
21. Since you are meeting the student's parents in person, you don't need a signature line, so also leave the "Include" check box clear for the Bottom Note option
22. To generate the report, click Run Report

Activity 7 – Run a Student Roster Report

In the middle of the term, you take your students on an annual field trip to the local art museum. Use the Student Roster report to take attendance and to keep track of student participation during the field trip.

1. Open the menu at the top of the gradebook window and select the class
2. Click Reports
3. Select Student Roster
4. Enter a report title, such as Field Trip Roster
5. Since you selected a class before you navigated to the Reports menu, it is already selected for the Classes option
6. To sort the roster of students by last name, open the Students menu and choose Last Name
7. Add columns of student information by opening the Add Columns menu and clicking Add next to Gender and Grade Level
8. Click Add next to Blank twice to include a column for taking attendance and one for tracking participation

A column titled "Name" is included by default to list the students' names.

9. Click the Add Columns menu again to close it
10. Enter Attendance as the title of the first blank column
11. Enter Participation as the title of the second blank column
12. Scroll to the top of the page and click the Students tab
13. Verify that the report applies to all of the students in the selected class
14. Scroll to the top of the page and click the Format tab
15. Open the Orientation menu and choose Portrait
16. Use the default option PDF for the report output

To work with the data in a spreadsheet, choose Excel.

17. Use the default settings for the rest of the format options
18. To generate the report, click Run Report
Working with PowerTeacher Pro – Bonus Activities

PowerTeacher Pro is a versatile gradebook that will support both traditional grading and standards-based grading practices. Work through these activities to gain in-depth familiarity with the new gradebook.

Bonus Activity 1 – View a Student's Standards Scores for a Single Assignment

A student comes to you after class to discuss a grade that she received on a recent test. Provide her with her scores and the full descriptions of the standards that were assessed on the test so that she'll know what topics to focus on next time.

1. Click Students
2. Click the name of the student
3. Open the Quick Menu by clicking the arrow at the end of the page name
4. Click Assignments
5. Locate the assignment in the list and click the Graph icon in the Standards column for that assignment

The Assignment Standards Detail window displays the full descriptions of the standards that were assessed on the test, the student's score for each standard, and any score indicator flags.

Bonus Activity 2 – View a Student's Standards Progress for a Single Standard

Select a student, find her term grades for a standard, and view the student's scores and calculated metrics for the standard.

1. From the class menu at the top of the page, select the class that the student is enrolled in
2. Click Students
3. Click the student's name from the list
4. Open the Quick Menu and select Standards Progress
5. Scroll down the table and locate a standard
6. On the right side of the table, click the icon in the Assignments column
7. Click Show Metrics to see the average of the three most recent scores, the mean, median, mode, weighted mean, and highest score

Key Points

- Working with Final Grades – View, modify, and recalculate traditional or standards final grades
- Analyzing Performance – Analyze a single student's progress or the progress of a whole class
- Running PowerTeacher Pro Reports – Use customizable report templates

Interaction 5 – Time for Review
Question 1

Where do you click to begin the task of analyzing the performance of an entire class?

Review what you've learned in this course. Click to view slide(s).
Copyright © 2017 PowerSchool or its affiliates. All rights reserved. All trademarks are either owned or licensed by PowerSchool or its affiliates. Other brands and names are the property of their respective owners.

Notes: